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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
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commercial license.
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© Copyright 2003–2007 Hewlett-Packard Development Company, L.P.
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Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

You can visit the HP software support web site at:

http://support.openview.hp.com/support.jsp 

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels and HP Passport, go to:

http://support.openview.hp.com/new_access_levels.jsp 
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1 Overview
This chapter covers the following topics:

• OVPI and the Ethernet Statistics Group

• Version history

• Integration with Network Node Manager (NNM)

• Ways to customize reports

• Sources for additional information

OVPI and the Ethernet Statistics Group

Performance Insight is a performance management application that collects data from many 
sources, performs in-depth trend analysis, maintains performance baselines, and provides 
users with convenient, web-based reporting. Following is a partial list of OVPI features:

• Distributed architecture

• Easy to scale (supports data collection from thousands of agents)

• CODA/OVPA agent support

• Multi-company security model

• Data warehousing

• Near Real Time reporting

• Forecasting 

• Extensive aggregation (by day, week, month; by location, by customer)

• Thresholding and alerting

• Easy identification of bottlenecks

• Easy assessment of capacity trends

• Accurate and timely documentation for management

RFC2821 defines the statistics and functions that an RMON probe exchanges with a console 
manager. The Ethernet Statistics Group is one of several data groups defined by RFC2821. 
Data in the Ethernet Statistics Group is produced by the following counters:

• Drop events

• Octets

• Packets

• Broadcast packets
7



• Multicast packets

• CRC alignment errors

• Undersized packets

• Oversized packets

• Fragments 

• Jabbers 

• Collisions 

• Packets containing fewer than 64 octets

• Packets containing between 65 and 127 octets

• Packets containing between 128 and 255 octets

• Packets containing between 256 and 511 octets

• Packets containing between 512 and 1023 octets

• Packets containing between 1024 and 1518 octets

The RMON Ethernet Statistics Report Pack installs on OVPI. Use the reports in this package 
to see what the counters listed above are picking up. The RMON Ethernet Statistics Report 
Pack includes the following reports:

1 Historical Broadcast/Multicast Packet Analysis 

2 Near Real Time Broadcast/Multicast Packet Analysis

3 Historical Packet Size Distribution 

4 Near Real Time Packet Size Distribution

5 Historical Error 

6 Near Real Time Error

7 Drop Events 

8 Inventory Report 

Historical reports compare yesterday’s performance to performance over the previous 31 days. 
Near Real Time reports assess performance over the previous 12 hours. The counts and 
percentages you see in a Near Real Time report factor in data retrieved by the most recent 
poll, which took place within the last few minutes.

Version History

The following table provides details about enhancements to RMON Ethernet Statistics.

Version Release Date Enhancements

1.0 May 2003 8 reports; Sybase support

2.0 October 2003 OVPI Object Manager support
8 Chapter 1



Integration with Network Node Manager (NNM)

If you use NNM as well as OVPI, you have the option of improving your ability to diagnose 
problems by integrating OVPI with NNM. In the past, you integrated NNM and OVPI by 
installing packages on both servers. This procedure recently changed. Package installation is 
no longer necessary, since both NNM and OVPI ship with the necessary packages already 
installed. Instead of installing packages, you run an integration script on the NNM server and 
you launch the Integration Wizard on OVPI.

If NNM and OVPI are integrated, or if you are about to integrate them, be sure to install the 
thresholds sub-package that comes with RMON Ethernet Statistics. Installing the thresholds 
sub-package configures the Thresholds Module to monitor the OVPI database for broadcast/
multicast threshold breaches and respond to a breach by taking an action. The default action 
is to send a breach trap to NNM. The breach trap received by NNM becomes an alarm in the 
NNM alarm browser, which the NNM operator can respond to by launching an OVPI report. 

Configuring the Thresholds Module is not necessary. You do not need to define an action or 
specify a destination for breach traps. However, you are free to modify category, severity, and 
destination parameters at any time. For details about these options, refer to the Thresholds 
Module User Guide.

Ways to Customize Reports

You can customize the reports in this package by applying group filters, by editing parameters, 
tables, and graphs, and by importing custom property data such as customers and locations. 
Service providers, or any organization that wants to share reports with customers, use group 
filters to produce customer-specific reports. Edits to parameters, tables, and graphs are 
temporary changes and anyone can make these changes.

3.0 April 2004 OVPI 5.0 support; Oracle support

3.0 August 2004 Upgrade package (to_3.0)

3.1 April 2007 new features:
• Location Independent Reporting (LIR)
• Supports Management Console > Copy Policy Manager

• Rate data removed from top-level table in NRT reports
• SQL modified for object delete
new upgrade package:
• UPGRADE_RMON_EthernetStatistics_to_31.ap
fixes the following defect: 
• QXCR1000089875

Version Release Date Enhancements
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Group Filters

If you intend to share reports with customers, you will need customer-specific reports. 
Creating customer-specific reports involves the following steps:
• Importing custom property information (customer names and device locations) using 

Common Property Tables 
• Creating a group account for all of the users affiliated with a particular customer
• Creating a group filter for the group account
For more information about group filters, refer to the OVPI Administration Guide. 

Editing Parameters

When you edit a parameter, you apply a constraint. The constraint eliminates data you do not 
want in the report. For example, if you edit the Customer Name parameter, data for every 
customer except the customer you typed in the Customer Name field will disappear. 

You can apply multiple constraints at once. RMON Ethernet Statistics supports the following 
parameters: 
• Customer Name
• Device
• Interface
• Protocol
• Location

If you are viewing the report remotely (using the Web Access Server), apply a constraint by 
clicking the Edit Parameters icon at the bottom right-hand corner of the report. When the 
Edit Parameters window opens, enter the constraint in the field and click Submit. 

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the 
Modify Parameter Values window opens, click Current Value. Type a new value and click OK.

Tables and Graphs

In addition to applying constraints, you can modify individual tables and graphs within a 
report. To do this, click the Edit Table and Edit Graph icons, or simply right-click the object if 
you are using the Report Viewer application. For details about view options for tables and 
graphs, see Appendix A, Editing Tables and Graphs.

Custom Property Information

All the property information that pertains to an interface (interface speed, customer, location, 
device name, and UtilThreshold) is inherited from the Interface Reporting Report Pack. If you 
want to change the utilization threshold, you can let OVPI read a property import file that you 
create yourself or you can work with the Change Protocol Defaults form that comes with 
Interface Reporting. For details, see Chapter 3, Changing Thresholds.
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Sources for Additional Information

The demo package that comes with RMON Ethernet Statistics contains a sample of each 
report in the package. If you have access to the demo package and you want to know what 
fully-populated reports look like, install the demo package. Demo reports are interactive; 
selection tables are linked to graphs, and you can experiment with parameters and view 
options. 

For information about recent enhancements to this package and any known issues, refer to:

• RMON Ethernet Statistics Report Pack Release Notes

The following documents are related to this manual: 

• Interface Reporting Report Pack User Guide

• Common Property Tables User Guide

• OVPI Report Packs, CD-ROM Release Notes, April 2007

Manuals for the core product, OVPI, and manuals for the reporting solutions that run on 
OVPI, are posted to the following web site:

http://ovweb.external.hp.com/lpe/doc_serv/

The user guides for OVPI are listed under Performance Insight. The user guides for report 
packs and datapipes are listed under Performance Insight Report Packs. Every user guide 
indicates a date. If a manual is revised and reposted, the date will change. Since we post 
revised manuals on a regular basis, you should compare the date on your PDF to the date of 
the PDF on this web site. If the web edition is newer, download the web edition.
Overview 11
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2 Package Installation
This chapter covers the following topics: 

• Guidelines for a Smooth Install 

• Upgrading to Version 3.1

• Installing RMON Ethernet Statistics

• Accessing Deployed Reports

• Package Removal

Guidelines for a Smooth Install

An OVPI reporting solution has two ingredients, a report pack and a datapipe. Some reporting 
solutions include multiple datapipes. When you install a datapipe, you configure OVPI to 
collect a specific type of performance data at a specific interval. When you install a report 
pack, you configure OVPI to summarize and aggregate the data collected by the datapipe.

If you install the RMON Ethernet Statistics Datapipe, you will configure OVPI to poll the 
RMON MIB. Installing the RMON Ethernet Statistics Report Pack configures OVPI to 
process data collected by the datapipe, generate trending analysis, and display the results of 
that analysis in a series of reports. 

The report pack CD-ROM contains report packs, datapipes, and several shared packages. 
When you insert the CD in the CD-ROM drive and launch the package extraction program, 
the install script on the CD extracts every package to the Packages directory on your system. 
When the extract finishes, the install script prompts you to launch OVPI and start Package 
Manager. Before using Package Manager, review the following guidelines.

Software Prerequisites

RMON Ethernet Statistics Reporting has a combination of core-product requirements and 
package-level requirements. The core product requirements are as follows:

• OVPI 5.2

• All available Service Packs for OVPI 5.2

You will find information about each service pack, including installation instructions, in the 
release notes for the service pack. The package-level prerequisites are as follows: 

• Common Property Tables 3.6

• Interface Reporting 5.2

• Interface Discovery Datapipe 2.4

• Interface Reporting ifEntry Datapipe 2.4
  13



Common Property Tables

If you are running an earlier version of Common Property Tables (version 3.5 or earlier), 
upgrade to version 3.6. Installing the upgrade package for Common Property Tables is no 
different from installing any other upgrade package; however, you cannot install other 
packages when you install this upgrade package. Install the upgrade package for Common 
Property Tables and only the upgrade package for Common Property Tables.

Running this Package in a Distributed Environment

If you intend to run RMON Ethernet Statistics as a distributed system across multiple 
servers, the central server, every satellite server, and every remote poller must be running the 
same version of OVPI and the same service packs. When you finish installing packages, you 
must configure the central and satellite servers. For details, see Chapter 4, Distributed 
Systems.

Upgrading to Version 3.1

If you are currently running an earlier version of RMON Ethernet Statistics, you can upgrade 
to version 3.1 by installing the “to_31” upgrade package. Follow this sequence:

1 Start Package Manager

2 Install UPGRADE_RMON_EthernetStatistics_to_31 (by itself, no other packages).

3 Click Done when the install finishes.

Before performing the preceding steps, you may need to save configuration data related to 
polling policies and polling groups. In addition, you may need to delete any views of data or 
property tables that you created yourself. If you do not delete custom table views, the report 
pack upgrade process may fail.

Datapipes and Remote Pollers

When you uninstall an existing datapipe, the following information will be lost:

• The polling policy for a single remote poller

• Cloned polling policies for multiple remote pollers

• Customized polling groups 

You can export existing polling policy configurations and customized polling groups by using 
the collection_manager and group_manager commands.

Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst
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Windows: As Administrator, launch a command window. Navigate to the OVPI install 
directory and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME

./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups

Custom Table Views

If you created custom views for data or property tables, the views you created may interfere 
with the report pack upgrade, causing it to fail. Whether or not your custom views interfere 
with the upgrade process depends on how you created them. If you created them using SQL, 
the upgrade will succeed, however, your custom table views will not be available once the 
upgrade is complete. If you created them using Datapipe Manager, the upgrade is likely to 
fail. To prevent the upgrade from failing, delete custom table views before you upgrade the 
report pack, then recreate these views after the upgrade is complete.

Installing RMON Ethernet Statistics 

Perform the following tasks to install RMON Ethernet Statistics on a stand-alone system:

• Task 1: Stop OVPI Timer and extract packages from the report pack CD

• Task 2: If necessary, upgrade Common Property Tables

• Task 3: Install the following packages:

— RMON_EthernetStatistics 3.1

— RMON_EthernetStatistics_Thresholds (optional)

— RMON_EthernetStatistics Datapipe 3.0

• Task 4: Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the report pack CD

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI timer and wait for processes to terminate.

On Windows, do the following:

a From the Control Panel, select Administrative Tools > Services.

b Select OVPI Timer from the list of services.
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c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu opens 
automatically. On UNIX, the CD may or may not mount automatically; if it does not 
mount automatically, navigate to the top level directory on the CD, and run the ./setup 
command. 

4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager install wizard opens.

When the copy to the Packages directory is complete, you can navigate to the Packages 
directory to see the results. The Packages directory contains separate folders for RMON 
Ethernet Statistics and the RMON_EthernetStatistics Datapipe. The following folders appear 
under RMON Ethernet Statistics:

• RMON_EthernetStatistics.ap

• RMON_EthernetStatistics_Demo.ap

• RMON_EthernetStatistics_Thresholds.ap

• UPGRADE_EthernetStatitiscs_to_31.ap

The following folder appears under RMON_EthernetStatistics Datapipe:

• RMON_EthernetStatistics Datapipe.ap

Task 2:Upgrade Common Property Tables

RMON Ethernet Statistics requires Common Property Tables 3.6. If you have not already 
upgraded Common Property Tables, install the upgrade package. When you install the 
upgrade, do not install other packages at the same time. Install the upgrade for Common 
Property Tables and only the upgrade for Common Property Tables. If you need help with the 
upgrade, refer to the Common Property Tables User Guide. 

Task 3:Install RMON Ethernet Statistics and the datapipe

1 From the Management Console, select Tools > Package Manager. The Package Manager 
welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory; or, if necessary, select a different 
directory.

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the defaults for application server name and port. Type your user name and 
password for the OVPI Application Server.

5 Click Next. The Package Selection window opens.

6 Click the check box next to the following packages:

RMON_EthernetStatistics

RMON_EthernetStatistics_Thresholds (optional)

RMON_EthernetStatistics_Datapipe
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7 Click Next. The Type Discovery window opens; accept the default.

8 Click Next. The Selection Summary window opens.

9 Click Install. The Install Progress window opens. When installation finishes, an install 
complete message appears.

10 Click Done to return to the Management Console. 

Task 4:Restart OVPI Timer

On Windows, do the following:

a From the Control Panel, select Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start

Accessing Deployed Reports

When you installed this report pack, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as any forms) were deployed to the OVPI Application Server. 
Once reports reside on the OVPI Application Server, you have two ways to view them:

• OVPI client applications

• Web browser

If the client applications are installed on your system, you have access to Report Viewer, 
Report Builder, and the Management Console. If the client applications were not installed on 
your system, you must use a web browser to view reports. 

For details about the client applications, refer to the OVPI Installation Guide. For details 
about the Management Console, including how to use the Object/Property Management view 
to launch reports related to a specific object, refer to the OVPI Administration Guide.

Package Removal 

Follow these steps to uninstall RMON Ethernet Statistics.

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI timer and wait for processes to terminate.

On Windows, do the following:

a From the Control Panel, select Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.
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On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click Uninstall.

6 Click Next. The Package Selection window opens

7 Click the check box next to the following packages:

RMON_EthernetStatistics

RMON_EthernetStatistics_ Thresholds (if installed) 

RMON_EthernetStatistics_Demo (if installed)

RMON_EthernetStatistics_Datapipe

8 Click Next. The Selection Summary window opens.

9 Click Uninstall. The Progress window opens. When removal finishes, a removal complete 
message appears. 

10 Click Done.

11 Restart OVPI Timer.

On Windows, do the following:

a From the Control Panel, select Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start
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3 Changing Thresholds
When you installed RMON Ethernet Statistics and deployed reports, you also deployed one 
form, the Change Threshold form. This form lets you perform a task related to an object. The 
object is either a device and all of its interfaces, or an individual interface. 

The Change Threshold form appears under Object Specific Tasks in the Object/Property 
Management window. This form (along with other forms) will be listed under Object Specific 
Tasks any time you select a device or an interface that is running the RMON probe.

The easy way to change the Broadcast/Multicast Threshold is to use the Change Threshold 
form. The more difficult way to modify the threshold is to create a file that includes a new 
threshold value, and then let OVPI import your file and update the property table. 

Putting Property Data in a File

You can create an import file by building it from scratch, by exporting the required attributes 
from your own provisioning database, or by letting OVPI collect some property data on its own 
and then exporting what was collected. Since building a property import file from scratch is 
not always easy, we recommend that you follow these steps:

1 Allow the system to discover a few devices on its own. 

2 Export existing property data from OVPI by typing this command:

trend_proc -f RMON_EtherStats_exportdata.pro 

3 Use the results as a starting point for a property file you will modify. 

4 Store your modified file in the correct directory (where OVPI expects to find it) and import 
the file by typing this command:

trend_proc -f RMON_EtherStats_importdata.pro 

If you do not type this command, OVPI will import your file at 4:00 a.m., well before daily, 
monthly, and forecasting summaries are started. If the default source and destination 
directories have not been modified, the import command will import data from, and the export 
command will export data to, the following directory: 

$DPIPE_HOME/data/PropertyData
  19



The following table describes the format of the Property Import file. If you are creating this 
file yourself, make sure that your file adheres to this format. The sequence of attributes left to 
right must follow this sequence of attributes top to bottom and your attributes must be 
delimited by tabs, not spaces. 

If you export this file from OVPI, the format will be correct; no checking is necessary.

Using the Change Threshold Form

The value for Broadcast/Multicast Threshold is defaulted to 50%. Follow these steps to open 
the Change Threshold form and modify the Broadcast/Multicast Threshold:

1 Open the Management Console.

2 Click the Objects icon.

3 Navigate to the interface you want to update and select it; or navigate to the device, if you 
want to update the threshold for all of the interfaces on that device, and select it.

4 The Change Bcast-Mcast Threshold form is listed along with other change forms under 
Object Specific Tasks.

5 Double-click the Change Bcast-Mcast Threshold form. The form opens.

6 Update the threshold as required.

7 Click Apply to save changes, then click OK to save changes and close the form. If you do not 
want to save the changes you made, click Cancel. 

Attribute Type Default Description

Node name char_string,64 N/A Device name.

Interface name char_string,188 N/A Interface name.

BcastMcastThreshold integer 50 Broadcast/ Multicast 
Threshold. The percentage of 
traffic of type Broadcast or 
Multicast.
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Conditions for Sending Traps to NNM

The thresholds sub-package that comes with RMON Ethernet Statistics 3.0 will send a 
threshold trap to your NNM server if the following two conditions are in effect at the same 
time:

• The Broadcast/Multicast Threshold is being exceeded.

• The Utilization Threshold is being exceeded.
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The utilization threshold is inherited from the Interface Reporting Report Pack. To modify 
this threshold, use the Change Protocol Defaults form, shown below. For more information 
about this and other forms bundled with Interface Reporting, refer to the Interface Reporting 
Report Pack 5.2 User Guide.
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4 Setting Up a Distributed System
This chapter covers the following topics:

• Proper package installation

• Configuring a central server

• Configuring a satellite server

• System clocks

Proper Package Installation

If you intend to run the RMON Ethernet Statistics package as a distributed system, you must 
configure all of the servers in the system. Before starting this task, use the following table to 
verify that your servers are running the right packages.

Typically, the central server does not poll. If you want the central server in your system to 
poll, then you must install the RMON_EthernetStatistics Datapipe on the central server.

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Register the satellite server by setting the database role

• Task 2: Enable LIR

Central Server Each Satellite Server 

RMON_EthernetStatistics 3.1 RMON_EthernetStatistics 3.1

Common Property Tables 3.6 Common Property Tables 3.6

Interface Reporting 5.2 Interface Reporting 5.2

Interface Discovery Datapipe 2.4 Interface Discovery Datapipe 2.4

IR ifEntry Datapipe 2.4 IR ifEntry Datapipe 2.4

RMON EthernetStatistics Datapipe 3.0

RMON_EthernetStatistics_Thresholds

Thresholds Module 5.1
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• Task 3: Add LIR mappings

• Task 4: Verify the automatically generated copy policies

• Task 5: Modify the trendtimer.sched file

Task 1: Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the database system.

4 Click Database Properties.

5 From the Database Role list, select the Satellite Server role.

6 Enter any information necessary to configure the Satellite Server role.

Task 2: Enable LIR

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3: Add LIR mappings

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 From the Select Satellite Server list, select a satellite server to which to add a mapping.

7 Select the Category data table option.

8 Select RMON Ethernet Statistics from the drop down list.

9 Select the rate data type.

10 Click Add to List.

11 If you want to add additional LIR mappings, click Add to list and repeat step 6 through 
step 10.

12 Click OK.

13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied that is defined in the generated copy policy (the type of data copied 

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.
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that is defined in the generated copy policy is for one greater than the data type selected in 
the LIR mapping). For example, if you select an hourly data type, a daily data copy policy is 
generated.

Task 4: Verify the automatically generated copy policies

Verify that a copy policy has been generated for the SHRMONEtherStats table and that the 
copy type is set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 Find the SHRMONEtherStats table and verify the copy type is set to Property and Data.

If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays.

2 Click Next. The Satellite Server and Copy Policy Selection Page displays.

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server.

4 Select Single Table and select SHRMONEtherStats from the pull down list.

5 Click Next. The Copy Type Selection Page displays.

6 Select Property and Data.

7 Click Next. The Summary page displays.

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back.

9 Click Finish.

If the copy type is not set to Property and Data, do the following:

1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Task 5: Modify the trendtimer.sched file

The trendtimer.sched file is found in the {DPIPE_HOME}/lib/ directory where 
{DPIPE_HOME} is the directory in which OVPI is installed.

Make the following change to this file:

• Find and comment out the following line:

1:00+25 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/EtherStats_Hourly_Process.pro

Configuring a Satellite Server

Follow these steps to configure each satellite server.

1 Modify the {DPIPE_HOME}/libtrendtimer.sched file (where {DPIPE_HOME} is the 
directory in which OVPI is installed). Find and comment out the following line:
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24:00+5:00 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/EtherStats_DMF_Process.pro

2 Modify the EtherStats_Hourly_Process.pro file.

The EtherStats_Hourly_Process.pro file is found in the {DPIPE_HOME}/scripts/ 
directory where {DPIPE_HOME} is the directory in which OVPI is installed.

Make the following change:

• Find and uncomment the following lines:

# begin: EtherStats_2 wait

# {DPIPE_HOME}/bin/perl {DPIPE_HOME}/scripts/IR_Performance.pl -p 
  "Sat_1_EtherStats_Copy" -t  hour -v start

# {DPIPE_HOME}/bin/trendcopy -t SHRMONEtherStats 

# {DPIPE_HOME}/bin/perl {DPIPE_HOME}/scripts/IR_Performance.pl -p 
  "Sat_1_EtherStats_Copy" -t  hour -v stop

# end: EtherStats_2

3 Configure polling policies for the RMON Ethernet Statistics Datapipe, making sure that 
each interface is polled by only one satellite server.

System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server. This step is extremely important. In distributed environments, linked 
processes must execute in exact sequences across independent machines.
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5 The Demo Reports
The chapter contains:

• A brief overview of the contents of each report (eight reports total)

• Screen captures

The screen captures come from the demo package.

1. Historical Broadcast + Multicast Packet Analysis

• Packet volume per interface for yesterday

• Ratio of broadcast traffic to multicast traffic for yesterday

• Multicast, broadcast, and unicast packets over two days (hourly)

• Multicast, broadcast, and unicast packets over previous 31 days (daily)

• Multicast and broadcast packet distribution for the previous 31 days 

• Interface utilization over the previous 31 days 

2. Near Real Time Broadcast + Multicast Packet Analysis [note: not illustrated]

• Packet volume per interface for the previous 12 hours

• The ratio of broadcast traffic to multicast traffic for the previous 12 hours

• Counts for multicast, broadcast, and unicast packets over the previous 12 hours

• Interface utilization over the previous 12 hours

3. Historical Packet Size Distribution

• Total number of packets for yesterday

• Percentage of packets with errors for yesterday

• Octets for yesterday

• LAN segment utilization for yesterday

• Packet size distribution for previous two days (hourly)

• Packet size distribution for previous 31 days (daily)

• Percentage of broadcast and multicast packets for the previous 31 days

• Interface utilization for the previous 31 days

4. Near Real Time Packet Size Distribution

• Total number of packets for the previous 12 hours

• Percentage of packets with errors for the previous 12 hours

• Octets for the previous 12 hours
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• Utilization for the previous 12 hours

• Packet size distribution for previous 12 hours

• Percentage of broadcast and multicast packets for the previous 12 hours

• Interface utilization for the previous 12 hours

5. Historical Error Report

• Packet volume per interface for yesterday

• Percentage of packets with errors for yesterday

• Percentage of packages with:

— Fragment errors

— CRCAlign errors

— Undersize errors

— Oversize errors

— Jabber errors

• Error count for the previous2 days (hourly)

• Error count for the previous 31 days (daily)

• Collisions for the previous 31 days

• Probe drop events for the previous 31 days

6. Near Real Time Error Report

• Packet volume per interface for the previous 12 hours

• Percentage of packets with errors for the previous 12 hours

• Percentage of packages with:

— Fragment errors

— CRCAlign errors

— Undersize errors

— Oversize errors

— Jabber errors

• Error count for the previous 12 hours

• Collisions for the previous 12 hours

• Probe drop events for the previous 12 hours

7. Drop Events Report

• Customer selection list

• List of devices associated with the selected customer

• Drop events per device for yesterday

• Drop events per interface for yesterday
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8. Inventory Report

• Customer selection list

• List of devices associated with the selected customer

• List of interfaces associated with the selected device
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A Editing Tables and Graphs
Any table or graph can be viewed in several ways. While the default view is usually adequate, 
you can easily change to a different view. If you are using Report Viewer, right-click the object 
to open a list of view options. If you are using the Web Access Server, follow these steps to 
change the default view of a table or graph:

1 Click Preferences on the links bar.

2 Expand Reports in the navigation frame.

3 Click Viewing.

4 Select the Allow element editing box.

5 Click Apply.

6 Click the Edit icon next to the table or graph. 

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.
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The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 
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View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 

The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.
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Style Options

Select Style to display a list of seven view options for graphs.

Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.

Option Function
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To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.

Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.
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Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.

Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.
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Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 

Display Data Table

This option changes a graph into a spreadsheet. 
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View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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Glossary
broadcast packet

A packet that is transmitted to all hosts on an Ethernet. The reports in the RMON Ethernet 
Statistics package show the ratio of broadcast packets to other types of packets.

collision 

A collision is the result of two devices on the same Ethernet network attempting to transmit 
data at exactly the same time.

drop event

An overrun at a port. The RMON port could not receive and process the traffic at full line rate 
and had to drop some packets from the counters. Changes in drop events can be caused by an 
overburdened RMON infrastructure.

fragment

A piece of a packet. Sometimes a communications packet being sent over a network has to be 
temporarily broken into fragments; the packet is reassembled at the destination.

jabbers 

Packets that were longer than 1518 octets and also contained alignment errors. 

multicast packet 

Communication between a single sender and multiple receivers on a network. The reports in 
the RMON Ethernet Statistics package show the ratio of multicast packets to other types of 
packets.

packet

A unit of data formatted for transmission on a network. Data is broken up into packets for 
sending over a packet switching network. Packet counts are shown with discard ratios.

port

Any frame relay interface on any network device that supports MIB-II.

octet

Eight bits. The term “octet” is sometimes used instead of the term “byte” to avoid confusion, 
because not all computer systems use bytes that are eight bits long. The reports in the RMON 
Ethernet Statistics package show octet counts on the LAN segment.

oversize packets 

The number of packets received that were longer than 1518 octets but otherwise well formed.
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